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ART 3.0 Preliminary Notes

1 Preliminary Notes

1.1 Proprietary Notice
The information in this document is proprietary to Güralp Systems Limited and may 
be copied or distributed for educational and academic purposes but may not be used 
commercially without permission.

Whilst every effort is made to ensure the accuracy, completeness and usefulness of 
the information in the document, neither Güralp Systems Limited nor any employee 
assumes responsibility or is liable for any incidental or consequential damages 
resulting from the use of this document.

1.2 Warnings, Cautions and Notes
Warnings, cautions and notes are displayed and defined as follows:

Warning: A black cross indicates a chance of injury or death if the 
warning is not heeded.

Caution:  A yellow triangle indicates a chance of damage to or failure of 
the equipment if the caution is not heeded.

Note:  A blue circle indicates indicates a procedural or advisory note.

1.3 Manuals and Software
All manuals and software referred to in this document are available from the  Güralp 
Systems website: www.guralp.com unless otherwise stated.
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2 Introduction

ART 3.0, Güralp Systems' Strong-Motion Analysis and Research Tool is a windows 
program which allows users of seismometers (accelerometers or velocimeters) 
produced by Güralp Systems Ltd, to process and analyse their recorded data for 
engineering seismology and earthquake engineering purposes.  The time-histories 
can be exported in a number of different strong-motion record formats that are 
currently in use today.

ART3.0 is a major update of the second version of ART (ART2.0), which was released 
in 2006.  A number of improvements were made following requests received from 
users, which are listed in section 6.1 on page 58.

ART 3.0 is supplied in the standard distribution of Scream! versions 4.5 and later.  It 
is also compatible with older versions of Scream!.

ART works closely with Scream! to make analysing seismic data easy.  Scream!'s 
visualization and filtering capabilities allow you to view time series and quickly 
identify events.  Strong-motion records can then be directly imported into ART from 
Scream! by selecting the appropriate portion of the record in Scream! - this will 
automatically start ART.  Previously recorded data in Güralp Compressed Format 
(GCF) can be read in from pre-recorded files and analysed.  In addition, data can be 
imported into ART via a modem.

Currently the following functions, which are important for engineering 
seismologists and earthquake engineers, are supported.  In addition most of these 
functions allow selection of multiple time-histories so a comparison between 
records is possible.

• plotting uncorrected acceleration, velocity and displacement against relative 
or absolute time;

• automatic correcting of recorded time-history for instrument response to 
obtain ground acceleration;

• filtering of acceleration time-history using user-defined filters;

• plotting corrected acceleration, velocity and displacement against relative or 
absolute time;

• calculation and plotting of Fourier amplitude spectra of time-histories and of 
pre-event portions of records including the signal-to-noise ratios;

• calculation and plotting of Arias intensities against time;

• calculation and plotting of energy densities against time;

• calculation and plotting, both on standard and tripartite graphs, of linear 
elastic response spectra;
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• calculation and plotting of linear elastic absolute and relative input energy 
spectra;

• calculation and plotting of drift spectra for a cantilever shear-beam for 
different material types;

• calculation of peak ground acceleration (PGA), peak ground velocity (PGV) 
and peak ground displacement (PGD);

• calculation of PGV/PGA;

• calculation of A95 parameter;

• calculation of sustained maximum acceleration and velocity;

• calculation of JMA instrumental intensities;

• calculation of response spectrum intensities using user-defined limits;

• calculation of acceleration spectrum intensities using user-defined limits;

• calculation of RMS acceleration, velocity and displacement;

• calculation of cumulative absolute velocities using user-defined minimum 
acceleration thresholds;

• calculation of absolute and relative bracketed, significant and uniform 
strong-motion durations using user-defined limits;

• calculation of number of absolute and effective cycles of acceleration using 
peak counting - including or excluding non-zero crossings and rainflow 
counting techniques;

• calculation of mean, predominant spectral, smoothed spectral predominant 
and average spectral periods;

• plotting particle motions both in two and three dimensions;

• basic database functionality to allow earthquake and station metadata to be 
added, used and exported;

• comparison of observed elastic response spectra to predicted spectra from 
various ground-motion prediction equations and seismic design codes;

• plotting of acceleration, velocity and displacement time-histories on map; 

• exporting the uncorrected and corrected spectra in these commonly used 
strong-motion record formats:

◦ Columns;

◦ CSMIP as used by the California Strong-Motion Instrumentation Program;

◦ ISESD as used by the Internet Site for European Strong-Motion Data;

◦ K-Net as used by Kyoshin Net;

◦ PEER as used by Pacific Earthquake Engineering Research Center;

◦ SMC as used by the US Geological Survey;

◦ SAC as used by Seismic Analysis Code;
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◦ Microsoft Excel .xls;

◦ Matlab .mat.
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3 Getting Started

The material in this chapter covers the installation, configuration and invocation of 
ART 3.0.

3.1 Installing ART
ART is included in the standard Scream! distribution for Windows, which is available
for free download.

ART uses the Matlab runtime library for its mathematical routines.  This is supplied 
as part of the installer and may be freely distributed.

To download Scream!, send an e-mail to scream@guralp.com, including information 
about your institution and the type(s) of equipment you are using.

To install the package, double-click on its icon and follow the instructions in the 
installer.  Choose the Typical installation option to ensure that ART and its 
supporting libraries are all installed.

3.1.1 A post-installation action…

ART is a compiled MATLAB program.  To comply with the MathWorks license, its 
support files are delivered as a compressed archive.  The very first time that the 
program is run, the archive is uncompressed, which requires administrative 
authority.  (Subsequent invocations use the previously uncompressed files.)

To avoid permissions problems, manually invoke ART once as administrator.  To do 
this, open windows explorer by keying +  and navigate to the folder into 
which ART was installed.  Right click-on ART3.exe and select “Run as administrator”
from the context menu:
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Windows will respond with a User Account Control screen:

Click to continue.  A command window will briefly appear and
then disappear.  ART should then be usable by any user, as described in the rest of 
this manual.

Note:  Failure to carry out this step can result in the error message

     "??? Undefined function or variable 'matlabrc'"
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3.2 Setting up sensor information
Before it can analyse data from your instruments, ART needs to know detailed 
calibration information for each one.

Note:  If you start ART from within Scream! (as in section 3.3.2 on page 14) 
without setting up the relevant sensor information, you will receive an 
error message saying:

A VPC= entry for {SYSTEM_ID-SERIAL} was not found
in calvals.txt

and you should follow the procedure in this section before re-trying.

The calibration information must be provided in a file called calvals.txt, which 
should be kept in the ART/Scream! program directory.  You can create and edit this 
file from inside Scream! by right-clicking on the digitiser's icon ( ) in the main 
window and selecting Calvals...

The file is divided into sections, each beginning with a title in square brackets.  The 
title gives the System ID and serial number (as given by the first four characters of 
the Stream ID) for the digitiser which produces the data stream.

For example: to add calibration information for a digitiser with System ID GURALP 
outputting streams DEMOZ2, DEMON2, DEMOE2, etc., you would add a section 
beginning with the line

[GURALP-DEMO]

If you move an instrument from one digitiser to another, you will need to update the 
calvals.txt file to reflect the change.

To set the serial number of the instrument, include the line

Serial-Nos=serial-number

Scream! cannot tell what instrument is connected to the digitiser.  This line is 
provided to help you remember which set of calibration values you have used, and to 
provide a title for calibration graphs.  If you attach a different instrument to the same
digitiser, you will need to enter new calibration values to reflect the new instrument.

To set the sensitivity of the digitiser, include the line

VPC=sensitivity

VPC stands for voltage per count, measured in units of μV/count.  This is sometimes V/count.  This is sometimes 
given as μV/count.  This is sometimes V/Bit on the digitiser calibration sheet.

To set the sensitivity of the calibration channel, include the line

CALVPC=sensitivity
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as for the other digitiser channels.

To set the value of the calibration resistor, include the line

CALRES=resistance

Güralp Systems digitisers normally use a 51 kΩ resistor (CALRES=51000).

To set the sensor type, include the line

TYPE=model-number

e.g. 3T, 5T, etc..

To set the response of the sensor, include the line

RESPONSE=response-type unit

The values you can use are given in the table below.

Sensor Sensor type code
(response-type)

Units
(V/A)

5TC, 5TD or 5T,
 DC – 100 Hz response

CMG-5_100HZ A

40T-1 or 6T-1,
 1 s – 100 Hz response

CMG-40_1S_100HZ V

40T-1 or 6T-1,
 2 s – 100 Hz response

CMG-40_2S_100HZ V

40T-1 or 6T-1,
 10 s – 100 Hz response

CMG-40_10S_100HZ V

40T, 20 s – 50 Hz response CMG-40_20S_50HZ V

40T, 30 s – 50 Hz response CMG-40_30S_50HZ V

3T or 3ESP,
 30 s – 50 Hz response

CMG-3_30S_50HZ V

40T, 60 s – 50 Hz response CMG-40_60S_50HZ V

3T or 3ESP,
 60 s – 50 Hz response

CMG-3_60S_50HZ V

3T or 3ESP,
 100 s – 50 Hz response

CMG-3_100S_50HZ V

3T or 3ESP,
 120 s – 50 Hz response

CMG-3_120S_50HZ V

3T, 360 s – 50 Hz response CMG-3_360S_50HZ V

3TB or 3V / 3ESP borehole, 30 s – 50 Hz response CMG-3B_30S_50HZ V

3TB or 3V / 3ESP borehole, 100 s – 50 Hz response CMG-3B_100S_50HZ V
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Sensor Sensor type code
(response-type)

Units
(V/A)

3TB or 3V / 3ESP borehole, 120 s – 50 Hz response CMG-3B_120S_50HZ V

3TB or 3V / 3ESP borehole, 360 s – 50 Hz response CMG-3B_360S_50HZ V

3TB or 3V / 3ESP borehole, 360 s – 50 Hz response CMG-3B_360S_100HZ V

Some English descriptions are also accepted, e.g. “120s velocity or 
“100Hz acceleration” but this is not a free-format field.

To set the sensitivities (or gains) of the sensor components, include the line

G=vertical-sens,N/S-sens,E/W-sens

These values are given on the sensor calibration sheet.  For velocity sensors, they are
given in units of V/ms-1).  The gain of an accelerometer is expressed in V/ms-2).  
Because Güralp Systems sensors and digitisers use differential inputs and outputs, 
the sensitivity is quoted as 2 × (single-ended sensitivity) on the calibration sheet.

To set the coil constants of the sensor components, include the line

COILCONST=ZCC,NCC,ECC

Where ZCC is the vertical coil constant, NCC is the North/South coil constant and 
ECC is the East/West cost constant.  These values are given on the sensor calibration
sheet.

To set the local acceleration due to gravity, include the line

GRAVITY=acceleration

You should give this value in V/ms-2, if you know it.  If you miss out this line, Scream!
will use a standard average g value of 9.80665 V/ms-2.

3.2.1 Examples

The calibration information for a Güralp 3T weak-motion velocity sensor might look 
like the following:

[GURALP-3T]
Serial-Nos=T3X99
VPC=3.153,3.147,3.159
G=1010,1007,1002
COILCONST=0.02575,0.01778,0.01774
CALVPC=3.161
CALRES=51000
TYPE=3T
RESPONSE=CMG-3_30S_50HZ V
GRAVITY=9.80122
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Güralp 5TD accelerometers use 1 Ω calibration resistors, and their coil constant is set 
to unity.  Older 5TD instruments, based on Mk2 digitiser hardware, do not have 
calibration input facilities, and thus the CALVPC entry is omitted.  For example:

[GURALP-5T]
Serial-Nos=T5585
VPC=2.013,2.028,2.036
G=0.256,0.255,0.255
COILCONST=1,1,1
CALRES=1
TYPE=5T
RESPONSE=CMG-5_100HZ A
GRAVITY=9.81089

3.3 Starting ART
ART can be started in two ways, either from SCREAM or by double clicking on the
ART icon.

3.3.1 Start from the ART icon

Double-clicking on the ART icon ( ) will start the application and cause the

main ART window to open.

Clicking on the ‘Import data’ button at the top of the left-hand column of the main
ART window opens up a file selection window from which a GCF time-history can be
selected to import and analyse.

3.3.2 Starting from SCREAM

Within Scream!, open a WaveView window displaying the event you are interested 
in.  Click on the Pause icon   to stop the traces moving then, using the mouse, 
select the parts of the time-histories that you want to analyse while holding down 
either the  or  keys.

If you use the  key, the first and last streams in the selected area will be 
analysed.  This is useful for picking two streams from many for comparison.  If you 
use the  key, a contiguous set of streams are selected.

When the  or  key is released, a pop-up menu will appear (after a short 
delay) asking which add-on program you want to run.  Select ART and the main ART 
window will open with the selected time-histories automatically loaded.
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The picture below shows a Scream! WaveView window with two streams selected 
(using the  key).

The second illustration shows the selection of two non-adjacent streams for 
comparison.  To do this, hold down the  key and drag a box from the start-time
on the first stream to the end time on the second stream.
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4 Using ART

The following sections discuss the features currently implemented in ART and how 
to use them.

When a time-history is loaded into ART, either via SCREAM, via the Import Data 
button (see below) or via the Event Manager, a correction for instrument response 
and, if required, a conversion to acceleration is automatically performed.  Low-pass 
filtering with a transition band given in ‘Options’ window (see below) is also 
undertaken, The algorithm used to remove the instrument response is the same as 
that used in BAP v1.0 (Converse & Brady, 1992) but the transfer function used to 
correct the time-history is derived from the poles and zeros of the originating 
instrument (e.g. a Güralp 5T). 

4.1 Importing data from Scream!
The most common and convenient way to get data into ART is to import them 
directly from a WaveView window within Scream!.  This is fully described in section
3.3.2 on page 14.  It is also straightforward to import GCF files without running 
scream.  This is described in section 4.2.1 on page 18.

4.2 The main ART window
The main ART window has:

• two columns of buttons (PROCESS and VIEW) for analysing and processing 
the selected time-histories;

• a list box in the middle for choosing which time-history is being processed 
and analysed; and 

• a text box at the bottom for displaying the metadata on the earthquake and 
station associated with the selected time-history (this information is only 
displayed if a single time-history is selected).
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The full window is shown here:

The following sections discuss the available functions starting with the left-hand 
column of buttons (PROCESS).
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4.2.1 Import data 

Clicking on the ‘Import data’ button at the top of the left-hand column opens up a file 
selection window from which the GCF time-history to import can be selected.

Many time-histories can be loaded into ART using this file selection window and, in 
addition, the window can be opened as many times as required to load in all the data 
required.  Once the required time-histories have been located, double clicking on the 
file-names (multiple records can be selected by holding down the Shift or Ctrl keys) 
or clicking on the file-names and clicking ‘Add’ will add them to the list of files to 
import (in the right-hand list box).  To import the data listed in the right-hand list 
box) click on ‘Done’ and their names will be added to the list given in the central box.
As stated above, the data are automatically corrected for instrument response and 
converted to acceleration, if required.
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4.2.2 Options

Clicking on the ‘Options’ button opens a window (see below) displaying the options 
that are currently used for display of acceleration, velocity and displacement 
parameters, appearance of some windows, filtering and for the calculation of the 
strong-motion parameters.  The parameters given in this window can be altered 
either by clicking in the white box next to the name of the parameter and editing its 
contents or by using the pull-down menus.

MAN-SWA-0003 19 Issue E - May, 2018



ART 3.0 Using ART

The parameters that can be changed in this window are:

1. units used for display of accelerations (‘Units for accelerations’) (g, ms-2, 
cm s-2 or mm s-2);

2. units used for display of velocities (‘Units for velocities’) (ms-1, cm s-1 or 
mm s-1);

3. units used for display of displacements (‘Units for accelerations’) (m, cm or 
mm); 

4. variable used for calculation of Fourier amplitude spectra (acceleration, 
velocity or displacement);

5. damping level used in figures comparing the response spectra of two or more 
records (0, 2, 5, 10 or 20%);

6. line styles used for figures comparing the derived strong-motion parameters 
of two or more records (monochrome or colour);

7. whether absolute time is reported on the graphs showing acceleration, 
velocity and displacement time-histories (yes or no); 

8. whether to use logarithmic or linear x-axes for graphs (logarithmic or linear);

9. whether to use logarithmic or linear y-axes for graphs (logarithmic or linear);

10. whether to use period or frequency for graphs and parameter display (period 
or frequency);

11. which variable to plot on maps displaying time-histories (acceleration, 
velocity or displacement);

12. which component to plot on maps displaying time-histories (Z, N or E);

13. whether to display range rings on maps displaying time-histories (yes or no);

14. whether to display metadata in title of figures (yes or no);

15. whether to display grid lines on figures (yes or no):

16. what COM port to use for dialling stations (COM1 is the only option currently 
supported);

17. what baud rate to use for dialling stations (2400, 4800, 9600, 19200, 38400, 
57600 or 115200);

18. length of pre-event time to use for calculating noise estimate (‘Length of pre-
event time’) in seconds (if this is set to zero then a noise spectrum is not 
calculated).  This can be selected interactively by clicking on the ‘Select’ 
button, see below;

19. corner frequency (‘fl’) in Hz of the bi-directional filter used for high pass 
filtering time-histories (usually this is about 0.05 Hz for records from Güralp 
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5Ts and it cannot be less than 0 Hz).  This can be selected interactively by 
clicking on the ‘Select’ button, see below;

20. order (‘Order’) of the Butterworth filter used for high pass filtering time-
histories (the default value for the order is 2, a higher order filter has a steeper
transition band but requires more zero padding and the filtering takes a 
longer time).  This can be selected interactively by clicking on the ‘Select’ 
button, see below;

21. frequency where cosine taper of low pass filter starts (‘fh1’) in Hz (usually this 
should be about 50 Hz for records from 5-series instruments);

22. frequency where cosine taper of low pass filter ends (‘fh2’) in Hz (usually this 
should be about 100 Hz for records from 5-series instruments);

23. acceleration threshold to use within the computation of cumulative absolute 
velocity (CAV) (this must be positive).  A commonly-used threshold is 0.025 g 
[0.245 ms-2];

24. the number of the peak to select for computation of the sustained maximum 
acceleration and velocity (this must be a positive integer).  A commonly-used 
value is 3, denoting the third peak;

25. acceleration used as the limit acceleration in the calculation of bracketed 
absolute duration (‘Bracketed Absolute’) in the selected units of acceleration.  
A commonly used limit acceleration is 0.05 g [0.49m s-2];

26. proportion of peak ground acceleration used as the limit acceleration in the 
calculation of bracketed relative duration (‘Bracketed Relative’).  This must be
between 0 and 1;

27. value of Arias intensity used as the lower threshold in the calculation of 
significant absolute (effective) duration in the selected units of velocity (see 
Bommer & Martinez-Pereira, 1999) (‘Significant Absolute (Start)’).  A 
commonly used lower limit is 0.01 ms-1; 

28. value of Arias intensity used as the upper threshold in the calculation of 
significant absolute (effective) duration in the selected units of velocity (see 
Bommer & Martinez-Pereira, 1999) (‘Significant Absolute (End)’).  A commonly 
used lower limit is 0.125 ms-1; 

29. proportion of Arias intensity used as the lower limit in the calculation of 
significant relative duration (‘Significant Relative (Start)’).  This value must be
between 0 and 1 - a commonly used lower limit is 0.05;

30. proportion of Arias intensity used as the upper limit in the calculation of 
significant relative duration (‘Significant Relative (End)’).  This value must be 
between 0 and 1 - a commonly used upper limit is 0.95;

31. acceleration used as the limit acceleration in the calculation of uniform 
absolute duration (‘Uniform Absolute’) in the selected units of acceleration.  A
commonly used limit acceleration is 0.05 g [0.49 ms-2 ];
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32. proportion of peak ground acceleration used as the limit acceleration in the 
calculation of uniform relative duration (‘Uniform Relative’).  This value must 
be between 0 and 1;

33. cyclic damage exponent to use for the computation of the effective number of 
cycles.  A commonly used value is 2;

34. period used as lower limit in calculation of spectral intensity (‘SI limits 
Lower’).  A commonly used lower limit is 0.1 s;

35. period used as upper limit in calculation of spectral intensity (‘SI limits 
Upper’).  A commonly used upper limit is 2.5 s;

36. period used as lower limit in calculation of acceleration spectral intensity 
(‘ASI limits Lower’).  A commonly used lower limit is 0.1 s;

37. period used as upper limit in calculation of acceleration spectral intensity 
(‘ASI limits Upper’).  A commonly used upper limit is 0.5 s.

38. the material to assume for the computation of the drift spectra (steel, R/C or 
other)

Clicking on the ‘Save’ button saves the chosen parameters to a file called 
art_default.dat which is loaded each time ART is used.  The parameters are not 
automatically saved when the window is closed using the close icon; however, they 
are used for the rest of the session.

4.2.3 Interactive selection of filter parameters

The Order and corner frequency fl of the Butterworth filter, as well as the Length of 
pre-event time, can be set interactively. 

1. Select a single stream in the centre panel of the main window.  Click Options.

2. In the Options window, beneath the legend Length of pre-event time, click the
Select button.  A window will pop up displaying the stream you have selected.

3. The top two graphs show the acceleration and displacement time histories 
for the selected stream, with the current low-pass filter applied.

4. The red line shows the current Length of pre-event time setting.  Data before 
the line are used to calculate spectra of ambient ground motion; data after it 
are treated as part of the event.

Click in either graph to move the line.  The spectra below are updated 
automatically.

5. The plot at bottom left shows the Fourier amplitude spectrum of ambient 
ground motion (in blue) and of the event (in black), using the current filter 
settings. 
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The plot at bottom right shows the ratio between the two spectra (i.e. the 
signal-to-noise ratio).  The horizontal red lines represent signal-to-noise 
ratios of 2:1 and 1:2; the blue lines represent ratios of 3:1 and 1:3.

The vertical red line in each graph shows the corner frequency currently 
being used for the low-pass filter.  Click in the graph to move it.  The time 
histories above are updated automatically.

6. To change the order of the applied filter, choose an option from the Order 
drop-down menu.  Filters of first to sixth order can be applied.

4.2.4 Add/edit metadata

Clicking on this button (this button is only enabled when a single time-history is 
selected in the central list box) will open a window that enables the user to enter, 
edit and delete basic metadata on the earthquake and station concerning the record 
selected.  Metadata that have already been entered in a previous use of ART are 
loaded into memory when ART is launched.  In addition, the meta-data are 
automatically saved to a file when this metadata window is closed.

Clicking on the ‘New earthquake’ button (or the ‘Edit earthquake’ button once a 
record is assigned to an earthquake) will open up a window where basic meta-data 
on the earthquake can be added (or edited).

Clicking on the ‘New station’ button (or the ‘Edit station’ button once a record is 
assigned to a station) will open up a window where basic metadata on the station 
can be added (or edited).

Clicking on the ‘Save and Close’ button saves the metadata and closes the window.

When metadata on earthquakes are in memory, the selected time-history can be 
associated (or re-associated) to an event by using the Earthquake combo-box.  
Similarly, when metadata on stations are in memory, the selected time-history can 
be associated (or re-associated) to a station by using the Station combo box.

MAN-SWA-0003 23 Issue E - May, 2018



ART 3.0 Using ART

4.2.4.1 Adding or editing earthquake information

The earthquake date and time fields are automatically filled by ART by using the time
at which the time-history begins.  However, this information can be modified by the 
user by clicking in the white boxes and modifying the values.  Similarly the user can 
modify the other event information reported in this window by clicking in the white 
boxes and modifying the text or by using the pull-down menus.

Once the user has entered the information on the event clicking on the OK button 
will store the entered metadata in memory and close the window.  If the Cancel 
button is selected the window is closed without storing the entered metadata.

4.2.4.2 Deleting earthquake information

If the user wishes to delete the entire set of information concerning the earthquake 
associated with a time-history then they should click on the ‘Delete earthquake’ 
button in the Adding and editing metadata window.  This will clear the metadata 
from memory and also will remove the link between the record and the event.

MAN-SWA-0003 24 Issue E - May, 2018



ART 3.0 Using ART

4.2.4.3 Adding or editing station information

The user can modify the information by clicking in the white boxes and changing 
the text or by using the pull-down menus.

Once the user has entered the information on the station clicking on the OK button 
will store the entered metadata in memory and close the window.  If the Cancel 
button is selected the window is closed without storing the entered metadata.

4.2.4.4 Deleting station information

If the user wishes to delete the entire set of information concerning the station 
associated with a time-history then they should click on the ‘Delete station’ button 
in the ‘Adding and editing metadata’ window.  This will clear the metadata from 
memory and also will remove the link between the record and the station.

4.2.5 Filter time-histories

Clicking on this button will filter the currently selected time-histories using a high 
pass bi-directional Butterworth filter with corner frequency and order given in 
‘Options’ window (‘fl’ and ‘order’ are the corner frequency and order used for the 
filtering).  The algorithm used to do the filtering is the same as that used in BAP v1.0 
(Converse & Brady, 1992), which zero-pads the time-history.

Note:  the time to accomplish the filtering has been significantly reduced 
in ART3.0 in comparison to earlier versions.
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4.2.6 Export data

Clicking on this button opens up a window 
that enables the user to export uncorrected 
acceleration time-histories, corrected 
acceleration, velocity and displacement 
time-histories, Fourier amplitude spectra, 
elastic response spectra, input energy 
spectra and drift spectra in a variety of 
different formats.  A new window is opened
with six buttons. 

Clicking on the top button will export 
uncorrected acceleration time-histories.  
Clicking on the next button down will 
export the corrected acceleration, velocity 
and displacement time-histories (if the 
time-histories selected have not been 
filtered then the uncorrected time-histories 
will be exported).  Clicking on the next 
button will export the Fourier amplitude 
spectra (the spectra will be calculated).  
Clicking on the next button down will 

export the calculated elastic response spectra (the spectra will be calculated).  
Clicking on the next button will export the input energy spectra (the spectra will be 
calculated) and clicking on the lowest button will export the calculated drift spectra.

When any of the six buttons are pressed, a file selection dialogue-box is opened, 
allowing the user to specify the name of the output file and the extension of this file.
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The extension must be given for the program to recognize in which data format to 
export the data.  A file-name is automatically suggested by ART based on the name 
listed in the central list box.  If the user has entered metadata concerning the 
earthquake and station associated with a time-history, this information is included 
within the exported files in agreement with the selected file format.  This is a 
significant improvement with respect to previous versions of ART.

4.2.6.1 ISESD

ART allows the exporting of uncorrected and corrected time-histories, response 
spectra and Fourier amplitude spectra in the data format of the Internet Site for 
European Strong-Motion Data (http://www.isesd.hi.is) and associated CD-ROM 
collections. 

When exporting data, choose the file extension for the export file according to the 
following table:

Type of data being exported file extension to use

uncorrected time-histories .raw

corrected time-histories .cor

Fourier amplitude spectra .fas

elastic response spectra .spc

input energy spectra .ene

drift spectra .ids

4.2.6.2 SMC

ART allows the exporting of uncorrected and corrected time-histories and response 
spectra in the SMC data format of the US National Strong Motion Program 
(http://nsmp.wr.usgs.gov/smcfmt.html).  When exporting any form of data use 
extension .smc.  For uncorrected time-histories and response spectra one output file 
is created with the specified name.  For corrected time-histories three output files 
are created, one with the stem (i.e. the file without the extension) plus _a.smc (for 
corrected acceleration), one with the stem plus _v.smc (for corrected velocity) and 
one with the stem plus _d.smc (for corrected displacement).

4.2.6.3 CSMIP

ART allows the exporting of uncorrected and corrected time-histories and response 
spectra in the data format of the California Strong Motion Instrumentation Program 
(http://www.conservation.ca.gov/dmg/csmip).  When exporting uncorrected time-
histories, use extension .v1; when exporting corrected time-histories, use 
extension .v2 and when exporting elastic response spectra, use extension .v3.
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4.2.6.4 K-NET

ART allows the exporting of uncorrected time-histories in the data format of 
Kyoshin-NET in Japan (http://www.k-net.bosai.go.jp/k-net/index_en.shtml).  When 
exporting uncorrected time-histories, use extension .ns, .ew or .ud depending on 
the component direction. 

4.2.6.5 PEER

ART allows the exporting of corrected time-histories and response spectra in the 
data format of the Pacific Earthquake Engineering Research Centre 
(http://peer.berkeley.edu/nga/).  When exporting corrected time-histories use the 
extension .at2 and when exporting response spectra use extension .000.  For 
corrected time-histories three output files are created, one with the name specified 
(for corrected acceleration), one with the stem specified plus the extension .vt2 (for 
corrected velocity) and one with the stem specified plus the extension .dt2 (for 
corrected displacement).  For response spectra five output files are created:

• one with the name specified (for 0% damping spectrum);

• one with the stem specified and extension .020 (for 2% damping spectrum);

• one with the stem specified and extension .050 (for 5% damping spectrum);

• one with the stem specified and extension .100 (for 10% damping spectrum); 
and

• one with the stem specified and extension .200 (for 20% damping spectrum).

4.2.6.6 Columns

ART allows the exporting of uncorrected and corrected time-histories, Fourier 
amplitude spectra, elastic response spectra, input energy spectra and drift spectra in
a column ASCII format.  When exporting files in this format, use extension .txt. 

4.2.6.7 SAC

ART allows the exporting of uncorrected and corrected time-histories in the data 
format of the Seismic Analysis Code (http://www.llnl.gov/sac/).  When exporting files
in this format, use extension .sac.

4.2.6.8 Microsoft Excel

ART allows the exporting of uncorrected and corrected time-histories, Fourier 
amplitude spectra, elastic response spectra, input energy spectra and drift spectra in
Microsoft Excel .xls format.  When exporting files in this format, use extension 
.xls.

Note:  to able to successfully export files in Microsoft Excel format, Excel 
itself must be installed on the user’s computer.
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4.2.6.9 Matlab

ART allows the exporting of uncorrected and corrected time-histories, Fourier 
amplitude spectra, elastic response spectra, input energy spectra and drift spectra in
Matlab native .mat format.  When exporting files in this format, use extension .mat. 

4.2.7 Clear time-histories

The ‘Clear time-histories’ button clears all the opened time-histories from memory.  
A confirmation dialog-box asks the user whether they are sure that they wish to 
clear all the time-histories from memory.  Clicking on ‘Yes’ clears the time-histories 
and clicking on ‘No’ retains the time-histories in memory.

4.2.8 Event Manager

This feature will be fully documented in Revision F of this manual.  Please contact 
support@guralp.com for further information.

4.2.9 ‘Unfiltered?’ check box

For each time-history in ART’s memory, either the unfiltered or filtered (if filtering 
has been applied) data can be used.  If the ‘Unfiltered?’ check box is ticked then the 
unfiltered version of the time-history will be selected.  Once filtering has been 
applied to the selected time-history then the ‘Unfiltered?’ check box will be un-
ticked.  To return to the unfiltered version simply click in the check box to tick the 
box again.  To then return to the filtered version click in the check box again. 

4.2.10 Central list box

This box lists those time-histories currently loaded into ART.  If the time-histories 
were selected in SCREAM then the time-histories are referred to by their work order 
and digitiser number.  If the time-histories were loaded through the ‘Import data’ file 
selection window the time-histories are referred to by their file-name.

In addition, the time-histories are allocated a unique six-digit identity number and a 
letter indicating the component direction so that they can be used by the ART 
database.  The files are listed in the order in which they were imported into ART. 

Clicking on time-histories' names will select those records to be processed and 
analysed.  Multiple time-histories can be selected for processing and analysis by 
holding down either the Ctrl or Shift keys.  Clicking on two or three time-histories 
from the same record will activate the ‘Particle motions’ button to enable the plotting
of the motion of a particle (hodogram) at the station.  Clicking on time-histories with 
associated earthquake and station metadata will active the ‘View time-histories on 
map’ button to enable the plotting of the time-histories on a map and also the 

MAN-SWA-0003 29 Issue E - May, 2018



ART 3.0 Using ART

‘Comparisons’ button to enable comparisons between the observed response spectra 
and predictions by GMPEs and seismic design codes.

4.2.11 Strong-motion parameters

Clicking on the ‘Strong-motion parameters’ button opens windows displaying a 
selection of strong-motion parameters for the selected time-histories.  The 
parameters that are displayed are (divided into the characteristic of the motion that 
the parameter seeks to measure): 

1. peak ground acceleration (PGA) in selected acceleration units and the time at 
which this occurs;

2. peak ground velocity (PGV) in selected velocity units and the time at which 
this occurs;

3. peak ground displacement (PGD) in selected displacement units and the time 
at which this occurs;

4. RMS acceleration in selected acceleration units calculated from

ARMS=∫ a t 2 dtT 
1/2

where T is length of record and a(t) is ground acceleration;

5. RMS velocity in selected velocity units calculated from

V RMS=∫ v t 2dtT 
1/2

where T is length of record and v(t) is ground velocity;

6. RMS displacement in selected displacement units calculated from

DRMS=∫ d t 2dtT 
1/2

where T is length of record and d(t) is ground displacement;

7. A95 parameter in selected acceleration units, which is defined by Sarma & 
Yang (1987) as the level of acceleration that contains up to 95% of the total 
Arias intensity;

8. sustained maximum acceleration in selected acceleration units, which is 
defined by Nuttli (1979) as the third (user-defined) highest absolute peak in 
the acceleration time-history;

9. slope of Husid plot in selected acceleration units, which is defined as the 
slope of the Arias intensity plot (Husid plot) between user-defined 
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percentages (those used for calculation of the relative significant duration) of 
the total Arias intensity (Bommer et al., 2004);

10. Japan Meteorological Agency (JMA) instrumental intensity, which is defined 
in http://www.hp1039.jishin.go.jp/eqchreng/at2-4.htm (see also Sokolov & 
Furumura, 2008) based on band-filtered acceleration time-histories (N.B.);

Note:   JMA instrumental intensity is usually defined for three 
orthogonal components but in ART it is computed for each 
component individually

11. sustained maximum velocity in selected velocity units, which is defined by 
Nuttli (1979) as the third (user-defined) highest absolute peak in the velocity 
time-history;

12. absolute uniform duration in seconds, which is the total time that the square 
of the ground acceleration is above the square of the ground acceleration 
specified in the ‘Options’ window;

13. relative uniform duration in seconds, which is the total time that the square 
of the ground acceleration is above the proportion specified in the ‘Options’ 
window of the square of the PGA;

14. absolute bracketed duration in seconds, which is the interval between the 
first and last instants where the square of the ground acceleration exceeds 
that specified in the ‘Options’ window;

15. relative bracketed duration in seconds, which is the interval between the first
and last instants where the ground acceleration exceeds a proportion 
(specified in the ‘Options’ window) of the maximum absolute acceleration.

16. absolute significant (effective) duration in seconds, which is the interval 
between the Arias intensity exceeding an absolute threshold specified in the 
‘Options’ window (‘Significant Absolute (Begin)’) and the Arias intensity 
exceeding the total Arias intensity minus another threshold specified in the 
‘Options’ window (‘Significant Absolute (End)’)  (Bommer & Martinez-Pereira, 
1999).

For example, if the thresholds are given as 0.1 and 0.125 ms-1 then the duration
is given as the interval between the Arias intensity exceeding for the first 
time 0.1 ms-1 to the total Arias intensity (e.g 0.5) minus 0.125 ms-1 (e.g. 0.375);

17. relative significant duration in seconds, which is the interval between the 
proportion of Arias intensity exceeding that specified in the ‘Options’ window
(‘Significant Relative (Begin)’) and the proportion of Arias intensity exceeding
that specified in the ‘Options’ window (‘Significant Relative (End)’).

18. response spectrum intensity (SI) in selected displacement units calculated 
from 

SI=∫PSV 5% ,T dT
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with the limits specified in ‘Options’ window, where PSV(5%,T) is pseudo-
spectral velocity for 5% damping and T is natural period [see Kramer (1996, p. 
83)] (note that this parameter is only calculated if the response spectrum of 
the time-history has already been calculated.  The response spectra 
calculation must be run again if the limits given in the ‘Options’ window are 
changed after the response spectra calculation was made);

19. acceleration spectrum intensity (ASI) in selected velocity units calculated 
from

ASI=∫ SA5% , dT
with the limits specified in ‘Options’ window, where SA(5%,T) is spectral 
acceleration for 5% damping and T is natural period [see Kramer (1996, p. 83)] 
(note that this parameter is only calculated if the response spectrum of the 
time-history has already been calculated.  The response spectra calculation 
must be run again if the limits given in the ‘Options’ window are changed 
after the response spectra calculation was made);

20. Arias intensity (AI) in velocity units based on the selected acceleration unit 
calculated from

AI= 
2g∫ a t 

2 dt

where g is acceleration due to gravity in ms-2 (i.e. g=9.80665 ms-2) and a(t) is 
ground acceleration (Arias, 1970);

21. normalized energy density (ED) in units based on the selected velocity unit 
calculated from

ED=∫v  t 2dt
where v(t) is ground velocity [see Sarma (1971)]

Note:  to get the true energy density, the normalized energy 
density should be multiplied by Vρ/4 where V is wave velocity 
and ρ is mass density of the recording site (Sarma, 1971)

22. cumulative absolute velocity (CAV) in selected velocity units calculated from

CAV=∑
i=1

N

H  PGAi−amin  ∫
t=t i

ti1

∣a  t ∣ dt

where a(t) is the ground acceleration, N is the number of 1-second time 
windows in the time series, PGAi is the PGA (in g) during time window i, ti is 
the start time of time window i, amin is an acceleration threshold (user-defined 
but commonly 0.025 g) to exclude low amplitude motions contributing to the 
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sum and H(x) is the Heaviside step function (unity for x>0 and 0 otherwise) 
(EPRI, 2006);

23. number of absolute effective cycles (peak counting including non-zero 
crossings) in acceleration time-history (Hancock & Bommer, 2005);

24. number of equivalent effective cycles using user-defined damage exponent 
(peak counting including non-zero crossings) in acceleration time-history 
(Hancock & Bommer, 2005);

25. number of absolute effective cycles (peak counting excluding non-zero 
crossings) in acceleration time-history (Hancock & Bommer, 2005);

26. number of equivalent effective cycles using user-defined damage exponent 
(peak counting excluding non-zero crossings) in acceleration time-history 
(Hancock & Bommer, 2005);

27. number of absolute effective cycles (rainflow counting technique) in 
acceleration time-history (Hancock & Bommer, 2005);

28. number of equivalent effective cycles using user-defined damage exponent 
(rainflow counting technique) in acceleration time-history (Hancock & 
Bommer, 2005);

29. predominant spectral period (or frequency) defined by Rathje et al. (2004) as 
the period at which the maximum spectral acceleration (using user-defined 
damping level) occurs;

30. mean period (or frequency) defined by Rathje et al. (2004) as:

Tm=
∑
i
C i
2 1/ f i 

∑
i
C i
2

where Ci are Fourier amplitudes at frequencies fi;

31. smoothed predominant spectral period (or frequency) defined by Rathje et al. 
(2004) as:

T 0=
∑
i
T i ln [ SA(T i )PGA ]

∑
i
ln [SA(T i )PGA ]

for Ti with SA/PGA 1.2 where 1.2 where Ti are periods at which the spectral 
accelerations SA are defined (using user-defined damping level);

32. average spectral period (or frequency) defined by Rathje et al. (2004);
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33. PGV/PGA in seconds (or Hz) (the ratio is computed using ms-1 for PGV and 
ms-2 for PGA), which gives an indication of the period (or frequency) content 
of the time-history;

At the top of this window there is a menu entitled ‘File’ with three options: ‘Save 
figure’, which saves a copy of the window as a graphics file (in .bmp, .eps, .jpg, 
.png or .tif format); ‘Print figure’, which prints a copy of the window; and ‘Export 
values’, which exports the strong-motion parameters to a text file in a space-
delimited format.

Also given as a header to the strong-motion parameter table (if the ‘Display 
metadata’ option is selected in the ‘Options’ window) are the basic earthquake, 
station and waveform metadata corresponding to the selected time-history (if 
available).

A typical strong motion analysis screen is shown here:
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4.2.12 View time-histories

Clicking on this button displays the time-histories of the record that is currently 
selected (uncorrected if the ‘Unfiltered?’ check box is ticked and corrected if the 
‘Unfiltered?’ check box is unticked) (see below).

If a single component is selected (or components from different instruments or with 
different start times) then the acceleration, velocity and displacement time-histories
of each time-history are displayed in separate windows.  If two or three components 
from the same instrument and the same start time are selected then clicking on this 
button displays the acceleration time-histories of the selected components in a 
single window.  If the user requested to display the absolute time of the record this is
displayed as a second x-axis on the figure.  The accelerations, velocities and 
displacements are displayed using their selected units.

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history (if available).

The user can zoom in on the three sub-figures by drawing a bounding box or by 
clicking on the sub-figures (the sub-figures are linked together so zooming in on one 
retains the correct time relation between the three sub-figures).  To zoom out again, 
right-click.
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At the top of this window there is a menu called ‘File’ with two items: ‘Save figure’, 
which saves a copy of the window as a graphics file (in .bmp, .eps, .jpg, .png or 
.tif format) and ‘Print figure’, which prints a copy of the window.  In addition, there 
is a menu called ‘Options’ that allows the user to modify the variable plotted 
(acceleration, velocity or displacement), the units used and whether to display grid 
lines on the figures.  Changes made here to these options are local and do not affect 
the global options that can be modified in the Options window discussed above.

4.2.13 View time-histories on map

If the user has entered earthquake and station metadata for the selected time-
histories, the ‘View time-histories on map’ button is enabled.  Clicking on this button
produces a map displaying the selected time-histories (only those for the same 
earthquake as the first time-history selected in the central list-box and for the 
component direction selected in the ‘Options’ window) at their geographical 
positions.  In addition, the epicenter of the earthquake is indicated as an asterisk as 
are range rings (if this option is selected in the ‘Options’ window) marking epicentral
distances of 1, 2, 5, 10, 20, 50, 100, 200, 500 and 1000km.

At the top of this window there is a menu called ‘File’ with two items: ‘Save figure’, 
which saves a copy of the window as a graphics file (in .bmp, .eps, .jpg, .png or 
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.tif format) and ‘Print figure’, which prints a copy of the window.  Also at the top of 
the window there is a menu called ‘Options’ that allows the user to modify the 
drawing options of this figure.

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.

4.2.14 Particle motions

When two or three components of the same record are selected the particle motions 
button becomes active.  Clicking on this button produces a plot of the motion of a 
particle (hodogram) at the station using the acceleration, velocity and displacement 
of the two or three time-histories.

If two time-histories are selected, a 2D plot is created with three graphs:

• the left-hand graph shows the acceleration of the first component (on 
the x-axis) against the acceleration of the second component (on the y-
axis);

• the middle graph shows the velocity of the first component (on the x-
axis) against the velocity of the second component (on the y-axis); and 

• the right-hand graph shows the displacement of the first component (on 
the x-axis) against the displacement of the second component (on the y-
axis).
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If three time-histories are selected a 3D plot is created with three graphs:

• the left-hand graph shows the acceleration of the first component (on 
the x-axis) against those of the second component (on the y-axis) and 
the third component (z-axis);

• the middle graph shows the velocity of the first component (on the x-
axis) against those of the second component (on the y-axis) and the 
third component (z-axis); and 

• the right-hand graph shows the displacement of the first component (on 
the x-axis) against those of the second component (on the y-axis) and 
the third component (z-axis).

The order of the components is always the same as that given in the list of time-
histories currently in memory.  When three components are selected the 3D particle 
motions plots also display projections of the motions onto the x-y, x-z and y-z 2D 
planes (if requested in the ‘Options’ menu at the top of the window).

The accelerations, velocities and displacements are displayed using their selected 
units.  Also shown in this figure (if the ‘Display metadata’ option is selected in the 
‘Options’ window) are the basic earthquake, waveform and station metadata of the 
selected time-history.
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At the top of this window there is a menu called ‘File’ with two items: ‘Save figure’, 
which saves a copy of the window as a graphics file (in these formats: .bmp, .eps, 
.jpg, .png or .tif) and ‘Print figure’, which prints a copy of the window.  Also at the 
top of the window there is a menu called ‘Options’ that allows the user to modify the 
drawing options of this figure.

4.2.15 Husid (Arias intensity) plot

As for other functions, this button has two behaviours depending on whether single 
or multiple time-histories have been selected.  The windows produced can be saved 
in different graphical formats (.bmp, .eps, .jpg, .png or .tif) using the ‘Save 
figure’ option on the ‘File’ menu and printed using the ‘Print figure’ option the ‘File’ 
menu.  Also the values plotted can be saved in a column format using the ‘Export 
data’ option on the ‘File’ menu.  The options used to create the figure can be changed 
within the ‘Options’ menu located at the top of the window.

The Arias intensities are displayed using units based on the selected acceleration 
unit.

4.2.15.1 Single time-history selected
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Clicking on this button will calculate and display the Husid plot (i.e. Arias intensity 
against time) of the currently selected time-history (see below).  The left hand axis 
gives the Arias intensity and the right hand side gives the percentage of Arias 
intensity.  Also displayed on the graph are dashed lines showing the times the 
intensity first exceeds the proportion of final Arias intensity given in the ‘Options’ 
window (‘Significant Relative (Start)’ and ‘Significant Relative (End)’.)

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.

4.2.15.2 Multiple time-histories selected

Clicking on this button when two or more time-histories are selected calculates and 
displays the Husid plots for all the selected time-histories on the same graph so that 
they can be easily compared (see below).  The figure is either displayed in colour or 
in monochrome depending on the option selected by the user within the ‘Options’ 
window.
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4.2.16 Energy density plot

As for other functions this button also has two behaviours depending on whether a 
single or multiple time-histories have been selected.  The windows produced can be 
saved in different graphical formats (.bmp, .eps, .jpg, .png or .tif) using the ‘Save 
figure’ option on the ‘File’ menu and printed using the ‘Print figure’ option the ‘File’ 
menu. 

The values plotted can also be saved in a column format using the ‘Export data’ 
option on the ‘File’ menu.  The options used to create the figure can be changed 
within the ‘Options’ menu located at the top of the window.

The normalized energy densities are displayed using units based on the selected 
velocity unit.

4.2.16.1 Single time-history selected

Clicking on this button will calculate and display the normalized energy density plot
[i.e. energy density against time (Sarma, 1971)] of the currently selected time-history. 
The left hand axis gives the normalized energy density [note that, to get the true 
energy density, the normalized energy density should be multiplied by Vρ/4 where V
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is wave velocity and ρ is mass density (Sarma, 1971)] and the right hand side gives 
the percentage of normalized energy density.  Also displayed on the graph are dotted
lines showing the times the energy density first exceeds the proportions of final 
normalized energy density given in the ‘Options’ window (‘Significant Relative 
(Start)’ and ‘Significant Relative (End)’).

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.

4.2.16.2 Multiple time-histories selected

Clicking on this button when two or more time-histories are selected calculates and 
displays the energy density plots for all the selected time-histories on the same 
graph so that they can be easily compared (see below).  The figure is either displayed 
in colour or in monochrome depending on the option selected by the user within the 
‘Options’ window.
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4.2.17 Fourier amplitude spectrum

Like the other buttons, this function has two behaviours depending on whether 
single or multiple time-histories have been selected.  The windows produced can be 
saved in different graphical formats (.bmp, .eps, .jpg, .png or .tif) using the ‘Save 
figure’ option on the ‘File’ menu and printed using the ‘Print figure’ option the ‘File’ 
menu.  The figures are either displayed in colour or in monochrome depending on 
the option selected by the user within the ‘Options’ window.  The options used to 
create the figure can be changed within the ‘Options’ menu located at the top of the 
window.

The Fourier amplitude spectra are displayed using units based on the selected unit 
for the selected variable (e.g. a unit based on the selected acceleration unit is used if 
the variable chosen to be displayed is acceleration).

4.2.17.1 Single time-history selected

Clicking on this button when a single time-history has been selected will calculate 
and display the Fourier amplitude spectrum of the currently selected time-history.  
No smoothing of the Fourier amplitude spectrum is applied.  Two Fourier amplitude 
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spectra are calculated: one using the pre-event portion of the record and one using 
the remainder of the record.  Comparing these two spectra enables a choice of the 
high-pass cut-off frequency to be made. 

The figure above shows an example where a cut-off frequency of about 1.5Hz is 
suggested by comparing the two spectra because for lower frequencies the signal-to-
noise ratio is quite low.

A sub-figure underneath can be requested in the ‘Options’ menu at the top of the 
figure to show the signal-to-noise spectral ratio computed using the Fourier 
amplitude spectra of the pre-event portion (as an estimate of the noise) and the 
remainder of the record (as an estimate of the signal).

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.

4.2.17.2 Multiple time-histories selected

Clicking on this button when multiple time-histories have been selected calculates 
and plots the Fourier amplitude spectra of the currently selected time-histories for 
the period after the pre-event portion of the record.
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4.2.18 Elastic response spectra

This function has two behaviours, depending on whether single or multiple time-
histories have been selected.  The windows produced can be saved in different 
graphical formats (.bmp, .eps, .jpg, .png or .tif) using the ‘Save figure’ option on the 
‘File’ menu and printed using the ‘Print figure’ option the ‘File’ menu.  The figures are 
either displayed in colour or in monochrome depending on the option selected by 
the user within the ‘Options’ window.  The options used to create the figure can be 
changed within the ‘Options’ menu located at the top of the window.

4.2.18.1 Single time-history selected

Clicking on this button when only a single time-history has been selected calculates 
and plots the elastic response spectra of the currently selected time-history for 2, 5, 
10 and 20% damping and periods between 0.04 and 15 seconds.  (The un-damped 
spectra are also computed but are not displayed due to their limited applicability in 
engineering seismology/earthquake engineering).  This calculation takes a few 
seconds for a normal length time-history.  The method given in Beaudet & Wolfson 
(1970) is used to calculate the spectra.  The spectra are plotted on tripartite and 
standard (logarithmic or linear, depending on the choice made in the ‘Options’ 
window) plots for spectral acceleration, spectral velocity and spectral displacement.  
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The spectra are displayed using the units selected by the user in the ‘Options’ 
window.

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.

4.2.18.2 Multiple time-histories selected

Clicking on this button when multiple time-histories have been selected calculates 
and plots the elastic response spectra of the currently selected time-histories for the 
damping level specified in the ‘Options’ window and displays them on the same sub-
figures so that they can be easily compared (see below).

4.2.19 Elastic input energy spectra

This function has two behaviours, depending on whether single or multiple time-
histories have been selected.  The windows produced can be saved in different 
graphical formats (.bmp, .eps, .jpg, .png or .tif) using the ‘Save figure’ option on the 
‘File’ menu and printed using the ‘Print figure’ option the ‘File’ menu.  The figures are 
either displayed in colour or in monochrome depending on the option selected by 
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the user within the ‘Options’ window.  The options used to create the figure can be 
changed within the ‘Options’ menu located at the top of the window.

4.2.19.1 Single time-history selected

Clicking on this button when only a single time-history has been selected calculates 
and plots the elastic absolute and relative input energy spectra and their equivalent 
velocities (e.g. Chapman, 1999) of the currently selected time-history for 2, 5, 10 and 
20% damping and periods between 0.04 and 15s.

The undamped spectra are also computed but are not displayed due to their limited 
applicability in engineering seismology/earthquake engineering.  The calculation 
takes a few seconds for a normal length time-history.  The method given in Beaudet 
& Wolfson (1970) is used to calculate the spectra.  The spectra are displayed using the
units selected by the user in the ‘Options’ window and using the other selected 
options.
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Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.

4.2.19.2 Multiple time-histories selected

Clicking on this button when multiple time-histories have been selected calculates 
and plots the elastic absolute and relative input energy spectra and their equivalent 
velocities (e.g. Chapman, 1999) of the currently selected time-histories for the 
damping level specified in the ‘Options’ window and displays them on the same sub-
figures so that they can easily be compared (see below).

4.2.20 Drift spectra

This function has two behaviours depending on whether a single or multiple time-
histories have been selected.  The windows produced can be saved in different 
graphical formats (.bmp, .eps, .jpg, .png or .tif) using the ‘Save figure’ option on the 
‘File’ menu and printed using the ‘Print figure’ option the ‘File’ menu.  The figures are 
either displayed in colour or in monochrome depending on the option selected by 
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the user within the ‘Options’ window.  The options used to create the figure can be 
changed within the ‘Options’ menu located at the top of the window.

4.2.20.1 Single time-history selected

Clicking on this button when only a single time-history has been selected calculates 
and plots the drift spectrum (e.g. Iwan, 1997) of the currently selected time-history 
for the selected damping level and material type and periods between 0.5 and 15s 
(see below).  This calculation can take many seconds for a long time-history.  The 
method given in Wang (1996) is used to calculate the spectra.  The spectra are 
displayed in terms of percentage of maximum inter-storey drift.

Also shown in this figure (if the ‘Display metadata’ option is selected in the ‘Options’ 
window) are the basic earthquake, waveform and station metadata of the selected 
time-history.
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4.2.20.2 Multiple time-histories selected

Clicking on this button when multiple time-histories have been selected calculates 
and plots the drift spectra (e.g. Iwan, 1997) of the currently selected time-histories for
the damping level and material type specified in the ‘Options’ window and displays 
them on the same graph so that they can be easily compared (see below).

4.2.21 Comparisons

Clicking on this button opens a new window (see below) that allows the user to 
compare the observed elastic response spectra of the selected time-histories with 
predicted median spectra from twenty-one recent GMPEs (e.g. Douglas, 2003) and 
three seismic design codes.  The GMPEs that can be selected by clicking on the 
check-boxes are the following:

1. Abrahamson & Silva (1997) (AS97);

2. Ambraseys & Douglas (2003) (AD03);

3. Ambraseys et al. (1996) /
Ambraseys & Simpson (1996) (AETAL96, AS96);
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4. Ambraseys et al. (2005a, b) (AETAL05);

5. Atkinson & Boore (1997) (AB97);

6. Atkinson & Boore (2003) (AB03);

7. Berge-Thierry et al. (2003) (BTETAL03);

8. Bindi et al. (2006) (BETAL06);

9. Boore et al. (1997) (BETAL97);

10. Campbell (1997) (C97);

11. Campbell & Bozorgina (2003a, b, c) (CB03);

12. Crouse (1991) (C91);

13. Kalkan & Gülkan (2004) (KG04);

14. Lussou et al. (2001) (LETAL01);

15. Ozbey et al. (2004) (OETAL04);

16. Sabetta & Pugliese (1996) (SP96);

17. Sadigh et al. (1997) (SETAL97);

18. Spudich et al. (1999) (SETAL99);

19. Toro et al. (1997) (TETAL97);

20. Youngs et al. (1997) (YETAL97);

21. Zonno & Montaldo (2002) (ZM02).

Predictions from these GMPEs are only displayed on the comparison graph if the 
required metadata (e.g. mechanism type) are available for the selected time-
histories.  In addition, some of the GMPEs are only for horizontal motions and 
therefore no predictions are displayed if only vertical components are selected.  
Also, some GMPEs are for specific site conditions (e.g. rock) and therefore no 
predictions are displayed if the selected time-histories were recorded at sites with 
different conditions.  The user is encouraged to study the original references [or the 
summaries by Douglas (2004, 2006, 2008)] for the limits of validity of the models and 
for which metadata are required.

The seismic design codes that can be selected are the following:

1. Eurocode 8 (European Committee for Standardization, 2002) (EC8);

2. Uniform Building Code 1997 (International Conference of Building Officials, 
1997) (UBC1997);

3. International Building Code 2000 (International Code Council, 2000) 
(IBC2000).
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UBC1997 and IBC2000 do not provide predictions for vertical spectra and so these are
not displayed if the time-histories selected are for the vertical component.  The user 
is encouraged to study these references for the limits of the validity of these seismic 
design code spectra.

Once the user has selected the GMPEs and the codes to compare with the observed 
elastic response spectra for the selected time-histories (and, if a seismic design code
has been selected, entered the necessary information), clicking on the Compare 
button opens a new window displaying the predicted and observed spectra (see 
below).  The predicted spectra are referred to by the abbreviations given above.
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6 Software Change History

6.1 Changes from ART 2
• Multiple time-histories can be selected for importation into ART.

• Absolute and relative input energy spectra can be computed, plotted and 
exported.

• Drift spectra for a cantilever shear-beam can be computed, plotted and 
exported.

• Various strong-motion parameters based on cycle counting can be computed 
and exported.

• Various additional strong-motion parameters can be computed and exported.

• Graphs can be customized in more ways compared to ART2.0.

• Records and derived parameters can be exported in Microsoft Excel .xls and 
Matlab .mat format. 

• Basic database functionality was added so that earthquake and station meta-
data can be recorded and used.

• Comparisons can be made between observed elastic response spectra and 
spectra predicted by various ground-motion prediction equations (GMPEs) 
and seismic design codes.

• Time-histories can be plotted on to maps to show the geographical 
distribution of ground motions.

• The software now supports accessing modem-connected instruments.

• The code was made more efficient leading to better performance.

• The software was made more user-friendly.

6.2 Changes from ART 1
• Adjusted absolute time of record to account for zero-padding added before 

instrument correction and filtering in display and when exporting.

• Added ability to export all derived strong-motion parameters (e.g. Arias 
intensity and Fourier amplitudes).
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• Correction for instrument response is now performed automatically when a 
time-history is loaded.

• Added ability to process and view many records at once.

• Comparisons between derived parameters (e.g. response spectral ordinates) 
from different records can by made.

• Added zoom in and out functionality to time-history windows.

• Graphs can now be exported in a variety of graphical formats (formats 
supported are: .bmp, .eps, .jpg, .png and .tif).

• Graphs can now be printed.

• Time-histories and derived strong-motion parameters can be displayed using
different units.

• Data from instruments with a velocity response can be imported, converted 
to acceleration and processed appropriately.

• A file-name is automatically suggested for the export of time-histories and 
derived parameters.

• Some minor bugs were corrected.

• The appearance of some windows was improved.

• Options have been add to allow the user to customize the appearance and 
functioning of some features.

• The code was made more efficient leading to slightly better performance.

• The polarity of the peak ground motion parameters is now displayed.

• The absolute significant (effective) duration is now computed.

• The cut-off frequency and order of the high-pass Butterworth filter can be 
chosen interactively using Fourier amplitude spectra of the signal and the 
noise (estimated from the pre-event portion of the time-history). 

• The units used to display accelerations, velocities and displacements can be 
chosen.
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7 Revision history

2018-05-22 E Updated graphics & clarified some explanations

2017-02-14 D Expanded installation instructions.

2016-10-24 Re-branding

2009-04-21 C Re-write for ART 3

2006-09-25 B Re-write for ART 2

2006-04-28 A Added revision history
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